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Description 

Building designers and site designers often live in different worlds. We differ in the way we think, 
the design problems we face, and how we traditionally approach and document our projects in 
Revit versus Civil 3D. What we do share is a client who expects us to collaborate effectively-—
regardless of the software we use.  
 
In this class, we will explore challenges faced when collaborating between Revit and Civil 3D – 
focusing specifically on how each software deals with internal coordinate systems and creating 
surfaces and topographies. We’ll explore what both sides really need from the other data-wise, 
the critical steps needed during import/export of the models, and the internal workflows for Revit 
teams when the building location needs to shift after coordinates are shared.  
 
Although we’ll briefly touch on available add-ins and recent BIM 360 collaboration options, we’ll 
be spending most of our time discussing a manual method that is immediately usable in any 
version of Revit or Civil 3D. 
 

 

Learning Objectives 

• Discover the innate differences between Revit and Civil 3D, and how to better discuss 
what you need from the other 

 

• Compare Revit and Civil 3D’s unique interpretations of TIN Surfaces, and what Revit 
needs for better surface creation 

 

• Define and share real-world coordinates between Civil 3D and Revit, and learn steps 
to take in Revit if the building must move  

 

• Learn how to identify and apply automation tools unveiled in recent releases of Revit, 
Civil 3D, and BIM 360 



 

 

ii 

About the Speakers 

 
Brianna Ladd 
Technical Specialist, ATG USA 
 
As a member of the Revit Architecture team at ATG, Brianna has spent the last five years 
supporting customers with specialized training, technical support, and consultation services.  
Prior to working at ATG, she modeled and assisted with the design of casework and lighting 
solutions for interior spaces.  
 
Kyle Groves, EIT 
Technical Specialist, ATG USA 
 
As a member of the Civil and Infrastructure team at ATG, Kyle has spent the last two years 
supporting customers with specialized training, technical support, and consultation services.  
Prior to working at ATG, he worked on land development projects for solid waste, residential 
and commercial projects.  Kyle received his B.S. in Geological Engineering from the University 
of Wisconsin-Madison. He is passionate about creative and sustainable solutions to the 
problems of today & tomorrow. 
  



 

 

iii 

Contents 

Learning Objectives ........................................................................................................................................ i 

Description ..................................................................................................................................................... i 

About the Speakers ....................................................................................................................................... ii 

Contents ....................................................................................................................................................... iii 

Introduction .................................................................................................................................................. 1 

High-Level Program Comparison .................................................................................................................. 1 

AUTOCAD Civil 3D ..................................................................................................................................... 1 

Revit .......................................................................................................................................................... 1 

What Civil 3D Wants from Revit ............................................................................................................... 2 

What Revit Wants from Civil 3D ............................................................................................................... 2 

Class Format .................................................................................................................................................. 3 

Class Part 1 ................................................................................................................................................ 3 

Class Part 2 ................................................................................................................................................ 3 

SECTION #1: Civil 3D Surfaces vs. Revit Topography (Manual) ..................................................................... 4 

Civil 3D -- Overview of Surfaces and Exporting ......................................................................................... 4 

Surfaces Overview ................................................................................................................................. 4 

Exporting a Site File (with TIN Surface) to Revit ................................................................................... 4 

Revit – Import Surface and Create Topography ....................................................................................... 5 

Do I need a separate Revit Site File? ..................................................................................................... 5 

Creating a Topography Surface ............................................................................................................. 6 

Civil 3D – Additional Points Needed for Revit ........................................................................................... 9 

Revit – Revising Toposurface When .DWG File is Updated .................................................................... 11 

SECTION #2: Locating Revit Models from Civil 3D Files (Manual): ............................................................. 11 

Civil 3D – Exporting to Revit .................................................................................................................... 11 

Revit – Acquire Coordinates from Civil’s File into a Site Model.............................................................. 12 

Revit – Publishing vs Acquiring Coordinates ........................................................................................... 14 

Revit – Acquire Revit Site Coordinates in the Building Model ................................................................ 14 

Revit – Test the Coordinate System ........................................................................................................ 17 

Revit – Export Building File back to Civil ................................................................................................. 17 

Civil 3D – Import  Revit’s Exported .DWGS in Real World Coordinates .................................................. 18 

file://///ATGMNFS01/User/kgroves/KG%20E/Webinar%20&%20MT/AU%202019/AS321319%20Cross-Discipline%20Coorindation%20C3D%20to%20Revit%20and%20Back%20Again/ClassHandout-AS321319-Ladd-Groves-AU2019%20v1.docx%23_Toc23195146


 

 

iv 

SECTION #3: Coordinates are Shared… and the Building Needs to Move .................................................. 19 

Revit – Initial Key Discussions ................................................................................................................. 19 

Single-Instance Building Projects – Initial Collaboration ........................................................................ 20 

Single-Instance Building Projects – Moving the Building ........................................................................ 21 

Multi-Instance Buildings on the Same Site ............................................................................................. 22 

SECTION #4: Additional Add-ins and Subscription Options ........................................................................ 24 

Shared Reference Point Extension .......................................................................................................... 24 

Civil 3D ................................................................................................................................................ 24 

Revit .................................................................................................................................................... 25 

Shared Topography Option in BIM 360 Design ....................................................................................... 26 

Civil 3D ................................................................................................................................................ 26 

Revit .................................................................................................................................................... 27 

Updating Linked Topography .............................................................................................................. 28 

CONCLUSION ............................................................................................................................................... 28 

 

 



 

 

1 

Introduction  

Autodesk Revit allows design teams to collaborate in true BIM fashion, using linked models to 
make educated design decisions throughout the development of a project across the whole 
team...well, ah…the whole Revit team at least.   
 
Since Civil disciplines are not using Revit, building teams tend to fall back to non-BIM strategies 
for coordination with Civil.  However, just like Revit users, Civil 3D users have an increasingly 
high demand for streamlined information gathering and data quality – in a sense, they are living 
in the same ‘BIM’ world as the Revit team, but without a conduit to the data.   
 
This class attempts to shorten the bridge between Civil 3D and Revit by discussing two common 
issues when collaborating between the two software: 1) surfaces vs. topographies, and 2) real-
world positioning of projects.  
 
Software Used:   Civil 3D 2019.1 & Revit 2019.2 
 

High-Level Program Comparison 

Autodesk Revit and Autodesk Civil 3D are… different. Remembering that each side is operating 
in a fundamentally different program is the starting point for any discussion about collaboration. 
 

AUTOCAD Civil 3D 
• Civil Engineering design software 

• Often used for infrastructure or city-wide projects  

• AutoCAD at its core (+ 3D) 

• Some parametric modeling… but mostly not 

• Not innately collaborative (plug-ins available) 

• Made for 3D surface creation and analysis 

• Always real-world coordinates 
 
 
 
 

Revit 
• Building Information Modeling (BIM) Software 

• Created for Building Design  

• Completely different workflow from AutoCAD 

• Parametric Modeling 

• Created for Collaboration (at least in Revit) 

• Does not read .dwg surfaces well 

• Internal Project Coordinate System 
 
 
 
  

FIGURE 1 – CIVIL 3D SCREENSHOT 

FIGURE 2 – REVIT SCREENSHOT 

https://www.google.com/url?sa=i&rct=j&q=&esrc=s&source=images&cd=&cad=rja&uact=8&ved=2ahUKEwjb8NSa1NzhAhVOQq0KHbiiAEUQjRx6BAgBEAU&url=https%3A%2F%2Fwww.autodesk.com%2Fproducts%2Fcivil-3d%2Ffeatures&psig=AOvVaw2e5CFqOW44nyzwTjryPck5&ust=1555780504052199
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Revit → Civil 3D Woes: Building design teams can hypothetically (ok, quite often) complete an 
entire building drawing set in Revit without any connection to actual real-world coordinates.  File 
exports from Revit must be manually placed in Civil 3D, and most of what is sent is 2D only.  
Read that again:  A designer in a 3D/Revit program most often saves a 2D plan… to send to a 
3D/Civil program.  Shame.     
 
Civil 3D → Revit Woes: Revit is not an AutoCAD program, and doesn’t always read .dwg data 
well -- particularly when creating topography surfaces from CAD files. The Revit Topo does not 
faithfully recreate the Civil 3D Surface. The Revit Topo is often visually distorted, especially at 
short vertical elevation changes where Revit just does its own thing (spiky curbs anyone?).   
 
In short, each side wants a little something from the other to have effective, streamlined 
collaboration. 
 

What Civil 3D Wants from Revit 
 

• Import Revit Building automatically at Architect’s intended location in real space  

• Import clean architectural footprint for drawings. 

• Import accurate 3D building information for a better understanding of building design intent 
(entrances, ADA, canopies, etc.) 

 

What Revit Wants from Civil 3D 
 

• Civil files that generate visually accurate surfaces in Revit  

• Dedicated layers for creation of topo and graphic control 

• Labeled NEZ point in cad file for reference/ check point  

• Ideally, a way to link in Civil Surfaces into Revit like other consultant’s files… with topo that 
updates automatically. 
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Class Format 

This class was presented as a 90 instructional demonstration session at Autodesk University, 
but treated as having two halves. The first half will discuss the manual workflow for 
collaboration, providing a foundation of understanding for making changes and the more 
automated workflows discussed in the second half. 
 

Class Part 1 
 
SECTION #1:  
Civil 3D Surfaces vs. Revit Topography (Manual Workflow):  
 

• Exporting and importing information between the programs 

• Why curbs sometimes look ‘spiky’ in Revit (and what can be done about it) 
 

SECTION #2:  
Real World Coordinates based on Civil 3D files (Manual Workflow):  
 

• Labeled NEZ points 

• Setup and overview of the Revit coordinate system 

• Acquiring vs. publishing coordinates (specifically in BIM 360)  

• Exporting files back to Civil 3D 
 

Class Part 2 
 

SECTION #3:  
If the model needs to move later in Revit…:  
 

• Tips for the Architect and Consultants working in Revit if/when the architecture 
model needs to move after coordinates are shared amongst the team. 

 

SECTION #4: 
Other Plug ins and BIM 360 Docs:  
 

• Introduction to the Shared Reference Point Add-in for Revit and Civil 3D) 

•  introduction to publishing/ linking Topography through BIM 360 Docs and the 
Autodesk Desktop Connector 
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SECTION #1: Civil 3D Surfaces vs. Revit Topography (Manual) 

Building designers often want accurate 3D grading information in Revit for system coordination 
and/or renderings with site context. And while Civil 3D’s shared files are incredibly accurate, 
Revit reads the .dwg data a little differently on its end. The resulting Revit Toposurface likely 
has a few issues that need addressing. 
 

Civil 3D -- Overview of Surfaces and Exporting 
 

Surfaces Overview 
 
AutoCAD Civil 3D is an AutoCAD program with tools and workflows geared specifically 
toward Civil Engineers to better coordinate and document land, water, and transportation 
projects in 3D space.   As seen in the image below, Civil 3D surface/grading is a 
complex network of 3D points and lines, all contributing to the overall TIN Surface 
(‘Triangulated Irregular Network’ Surface). 
 

 
FIGURE 3 – CIVIL 3D SURFACE CLOSEUP 

 
Revit users build their Toposurfaces from points available on chosen layers in the 
Civil’s exported .dwg, and often assume they simply need points along topo Lines to 
generate an accurate Toposurface. The Civil 3D surface, however, has many additional 
points outside of Topo Lines that would be ignored if only topo layers/lines were used.   
 
As a better practice, provide the TIN surface itself on a dedicated layer in Civil 3D 
exports for selection within Revit. 

Exporting a Site File (with TIN Surface) to Revit  
 

1. Right click on the Civil 3D Surface and select Edit Surface Style. 
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2. Click on the Display Tab. Make sure that ‘Triangles’ are visible and are set to a 
dedicated layer so the TIN data can be independently chosen from within Revit. 

FIGURE 4 - SURFACE STYLE PROPERTIES DIALOG  

 

3. You are ready to export the file. Select the Civil 3D Menu  and then the ‘Export’ 
option. Select ‘Export Civil 3D Drawing’ to open the .dwg dialog window. 
 

4. In the ‘Export Autodesk Civil 3D Drawing’ Pop-up window: 
a. Export to File type: AutoCAD DWG 
b. External DWG references: Bind and Insert (or user preference) 
c. Files to Export: Current drawing only (typical) 
d. Include Sheets: Uncheck 
e. Select the ‘Export Settings’ button and make sure that ‘Export Feature 

Lines’ is set to ‘3D’. 
f. Name/Save as desired and send to the Revit team. 

 

Revit – Import Surface and Create Topography 
 

Do I need a separate Revit Site File? 
 
The first decision to make in Revit is whether to create the Toposurface in your 
architectural building model or in a separate site model.  This decision is largely user-
preference; however, the following rules generally apply: 

 
Create a Separate Site Model if any of the following are true: 

 

• You will have multiple buildings (separate project files) on the same site 

• You will have a significant amount of site content or entourage which could 
negatively affect your building model’s file size 

• You have a large or complex site (also a file size issue) 

• You anticipate doing renderings or walkthroughs of the site while needing to work 
simultaneously on project documentation 
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It is generally recommended to standardize how site files are handled across 
your company’s projects for user consistency. For this reason, many firms 
typically default to: ‘keep-the-site-file-separate’ to cover more options.  For this 
walkthrough, we will be importing the CAD file into a blank, stand-alone site 
project.  
 

 

Creating a Topography Surface 
 
1. Open a new Revit project using your desired Template. 

 
2. Open the default Site Floor Plan View 

 
3. On the Insert Tab in the Ribbon, select Link CAD, and browse for the desired .dwg 

file provided by the Civil Engineer. 
 

4. In the pop-up window prior to opening the file, select the following: 
a. Colors: Black and White (or user preference) 
b. Layers/Levels: All 
c. Import Units: Auto Detect 
d. Correct lines that are slightly off axis:  UN-check.  Real world surveys are likely 

never straight… we want accuracy here. 
e. Positioning: Auto – Center to Center   

 
Note: Origin to Origin positioning will likely give you a warning due to the 
distance of the cad file’s origin point away from the actual drawn data, 
ultimately defaulting to Center to Center.  
 
Note: ‘By Shared Coordinates’ is not appropriate here, since the files are 
not yet sharing the same coordinate system. 

 
f. Place at: Level 1 
g. Orient to View: Yes 
h. Select ‘Open’. 
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5. The imported cad file data is in 3D, showing point/surface data at accurate heights.  
If you don’t see the imported cad file in your Site plan view, modify the Site Plan 
View Range in the Properties Browser to be higher than your site.    

 

 
FIGURE 5 - FLOOR PLAN VIEW   FIGURE 6 - 3D VIEW  

 
6. Open your 3D view.  On the Massing & Site Tab on the Ribbon, select 

‘Toposurface’ and the Ribbon will update with additional tool options. Select ‘Create 
from Import’ → ‘Select Import Instance’.  Select the .dwg file in your view you 
want to create a Toposurface from.   
 

7. Revit will be creating its Toposurface from points provided in the linked file.  In the 
pop-up window titled ‘Add Points from Selected Layers’, limit the selection to only 
layers relating to topography. If the Civil Engineer has added his/her TIN surface on 
a dedicated layer, select it here (See Civil 3D walkthrough above).  Finish and ‘ok’ 
the selection. 
 

8. Revit has added points based matching locations of points in the layers you have 
chosen.  In the Ribbon, select the green checkmark to create the Toposurface. 

 

9. Let’s review the topo surface.  In the 3D view, select and hide the cad file. In this 
example, the Visual Style of the view has been changed to ‘Consistent Colors’ to 
better see the result.  From afar, we can observe that the topography has a 3D 
shape, and that general locations of cubs are shown. But when zoomed in, it is 
obvious that the curbs have not been created as intended. 
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FIGURE 7 - CREATED TOPO SURFACE  FIGURE 8 - TYPICAL CURB CONDITION 

 
The images above show a common problem with how Revit reads and interprets surface 
data in a .dwg file. This unintended result is due to Revit’s inability to read and 
implement Civil 3D’s breaklines in a Surface. Typically, but not always, these are either 
Survey Figures for existing data, or Feature Lines for proposed design data.  
 
In Civil 3D, breaklines are added along vertical edges to force the surface to triangulate 
between points in a specific, controlled way—allowing for fine detailing and fairly smooth 
surfaces regardless of the spacing of existing/design data.  
 
Revit, in contrast, creates the Toposurface only from the actual points/nodes 
themselves. It basically discards Civil 3D’s surface and recreates its own surface by re-
triangulating between available points, always connecting to the next closest point.   
 
Voila… spiky curbs.  
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10. If curbs and other vertical surfaces appear particularly ‘spiky’, consider decreasing 
the contour interval of the Toposurface in Revit.  Some of the jagged edges are 
cleaned up, but the curbs are likely still not as intended. 

FIGURE 9 - CREATED TOPO SURFACE 

 
If a Revit team only needs or wants a Toposurface for general grading/section 
coordination, then this issue might not be much of a problem.  However, if the design 
team needs to use the Toposurface in presentations or renderings for the owner… then 
more can be done on the Civil 3D end in anticipation of how Revit deals with data. 
 
Note: For projects in BIM 360, refer to the ‘Linked Topography’ workflow towards the end 
of this class, which seems to fix a lot of the ‘Revit Translation’ issues--including 
smoothing out curbs.  For non-BIM 360 projects, the following provides an alternate 
solution. 
 

Civil 3D – Additional Points Needed for Revit  
 

Civil 3D users can help this issue by adding extra COGO points along intended 
breaklines (Feature Lines, Survey Figures) at key vertical rises across the site. Since 
Revit cannot define breaklines, the TIN points of the Civil 3D Surface must be so closely 
spaced that Revit will have no choice but to connect the “nearest neighbors” in the way 
that the Civil 3D Surface intended. 
 

 
1. On the Home tab, select Points → Create Points Miscellaneous → Measure 

Object.  
 

2. Each desired Feature Line / Survey Figure that should be treated as a breakline 
(tops and bottoms of curbs, etc.) must be individually selected, and set with the 
desired point spacing.  
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a. In the Points Creation dialog, consider setting the “Prompt For Descriptions” 
option to “Automatic – Object” and pre-populate the Default Description. This 
will create all COGO Points with a single command. Either choose a 
Description that is outside of the Description Key Set (DKS) or add a specific 
code to the DKS for this purpose. 

 

 
 

FIGURE 10 – DEFAULT POINT CREATION OPTIONS 

 
b. The horizontal spacing of points along feature lines should be no greater than 

the adjacent vertical distance of rise or fall.  For example, at 6” vertical curbs, 
the horizontal COGO point spacing at the top and bottom of the curb should 
be no greater than 6” 

 
3. Once finished, add the newly created points to a Point Group. Add the point group 

to a new Surface. This heavily COGO Point-ed surface will have tons of new 
triangulation, which will not be appropriate for most Civil 3D uses. It can be set to a 
“No Display” Style until the drawing is ready for Export (see Step 3 of Exporting a 
Site File (with TIN Surface) to Revit, above) 

 
The architect and civil engineer should discuss key site areas that will need a 
higher visual fidelity in Revit, thus requiring this additional workflow on the Civil 
side (it may not be needed everywhere, or even at all for a project). To avoid 
‘scope creep’, consider including requirements for ‘Surface Prep for Revit’ in your 
BIM execution plan, contract language, and project kickoff discussions. 
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Revit – Revising Toposurface When .DWG File is Updated 
 

Revit’s Toposurfaces do not automatically ‘update’ when newer versions of the Civil 
3D file are shared and the link is refreshed; but the topography you have in place can 
be updated with a little bit of manual cleanup. 
 
1. On the Manage Tab → Manage Links → CAD Formats Tab, Select Civil’s site 

model from the list and chose ‘Reload From…’ to browse to the updated file 
location and update in place. Select OK. 
 

2. In a 3D view, select your existing Toposurface and select ‘Edit Toposurface’ 
from the Ribbon.   

 
You can now see your existing points that were initially created. The simplest course of 
action is to delete all the points and create new points from the current .dwg.   Since you 
are editing the same Toposurface you had, any Surface Regions or hosted items 
should still exist where you left them, once finished. 
 

3. Delete all points in the view.  Select ‘Create form Import’ from the ribbon and 
select the updated cad file. Finish the Toposurface.   

 

SECTION #2: Locating Revit Models from Civil 3D Files (Manual):  

Revit users aren’t required to position their building in real world coordinates to produce a 
document set… and honestly, most don’t. The Revit coordinate system has a reputation as 
cumbersome, awkward, and unintuitive.  And if the building needs to shift later… heaven help 
us.   
 
But we also know the industry is ever progressing toward ‘True BIM’, where BIM data doesn’t 
stop at the edge of the Revit team’s silo, and team collaboration reaches further and further past 
design.  In today’s data-centric, technology-forward world, non-Revit team members 
(contractors, surveyors, Civil Engineers, etc.)  all benefit from a correctly positioned building.  
 

Civil 3D – Exporting to Revit 
 
1. Provide a labeled COGO NEZ reference point (northing, easting, and vertical 

location) on your site plan for the Architect to reference/check against when adjusting 
Revit for real world coordinates. 
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2. Export the Civil 3D file according to Section #1 
(above).  
 
Note: Ideally, this point would be at a property 
corner or other site location that will not change… 
but it could also be at an established building 
corner or grid intersection if the building location 
has been previously coordinated. 

  
 

Revit – Acquire Coordinates from Civil’s File into a 
Site Model 

 
We discussed importing the Civil 
file into Revit in Section #1 when 
we looked at topography surfaces.  
The Toposurface we created in 
Revit was draped over the provided 
.dwg file but had not yet been geo-
located to match Civil. 
 
1. In the Site Model, open the 
Site Plan to view the linked .dwg 
file. 
 
Note: If your Survey and Project 
Base Points are not visible, turn 
them on in the view’s Visibility 
Graphics under Model Categories 
→ Site. 

                                  FIGURE 12 - REVIT SITE PLAN VIEW 

 
Since we had imported the .dwg file ‘center to center’, the .dwg file is centered over 
Revit’s default Survey and Project Base Point Locations (Revit’s 0,0,0 point) 
 
A quick review of Revit’s Survey and Project Base Points. 

 
The Survey Point represents a known, 
surveyed location in the physical world. 
Revit Levels and Spot Elevations that 
are set to reference the Survey Point in 
their Type Properties will show a height 
relating to this Survey Point.  When 
coordinating with Civil, this is the point 
we are interested in. 
 FIGURE 13 – REVIT SURVEY POINT 

  

FIGURE 11 – COLLABORATION REFERENCE 

COGO POINT 
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The Project Base Point defines a 
measuring point for project documentation. 
These points are often located at the first-
floor level of a project so that Levels/Spot 
Elevations referencing them will indicate 
heights above Finish Floor. 

 
FIGURE 14 – REVIT PROJECT BASE POINT 

 
2. Select the Survey Point and note its location.  By default, it reads 0,0,0 for its 

northing, easting and vertical height. 
 

3. Notice the engineer’s labeled NEZ point (Figure 11) indicates that that corner point 
should be 124,000+ feet north of 0,0… which is definitely not the case here in 
Revit… yet. 

4. On the Manage Tab, Project Location area, select Coordinates , 
and then Acquire Coordinates. 
 

a. Select the Link you wish to acquire coordinates from. Coordinates from the 
linked .dwg file have been now pulled into the Revit project. 

 

5. Select the Survey Point again and note that it now has numbers in the ballpark of 
the engineer’s labeled NEZ point. The numbers will not match the NEZ in our case 
since our Survey Point is still positioned at the center of the site. 

 

6. If you want to check if the coordinates are acquired exactly, you can move the survey 
point on top of the engineer’s provided NEZ point.   

 

a. Select the Survey Point and Unclip it by clicking on the paper clip symbol 
next to it (very important).  

 

Note: You should see a red diagonal line through the paperclip before you 
move the Survey Point.  Unclipping the Survey Point essentially means you 
are lifting up the Survey Point and setting it down again to read numbers 
from another location. 

 

b. Once positioned over the NEZ point, re-clip the Survey Point and note that 
the N and E readings match, but the vertical height of the Survey Point itself 
is down at 0. This is correct. However, if you want the Z to match (also ok), 
unclip the Survey Point and move it up in elevation to the desired height. 
Reclip it when done. 
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Side Note: The Project Base Point defaults to a height of 0 as well.  If you want 
to relocate the Project Base Point to your first-floor level, unclip it before you 
move it vertically or horizontally and reclip it when it is at its desired location. 
Otherwise it will try to pull the cad file with it as it moves. 

 

Revit – Publishing vs Acquiring Coordinates 
 
Now that the Site model matches Civil model’s coordinate system, we can use it to 
establish coordinates in other Revit files. 
 
Revit has two primary options for sharing coordinates between Revit Projects, both 
found under the Manage Tab → Project Location area → Coordinates. 
  

1. Publish Coordinates: Used when coordinates are already established in 
your project file and you wish to PUSH your coordinate system into a linked 
model that is placed correctly in your file. 

 
Note: When publishing coordinates into a linked file, Revit essentially opens 
the linked file, changes its coordinate system, and saves it again.  It’s 
important that no one is working in the linked in file during this process.   
 
Note: In BIM 360 Cloud projects, this Publish Coordinates option is 
disabled.  For this reason, the workflow in this class will focus on the 
‘Acquiring Coordinates’ method. 
 

2. Acquire Coordinates: Used when your linked model has the correct 
coordinates, and you want to PULL them into your model. The linked model 
should be placed accurately in XYZ space prior to acquiring the coordinates. 

 

Revit – Acquire Revit Site Coordinates in the Building Model 
 
Revit projects are typically started in Project North orientation – that is, rotated for the 
most efficient documentation on sheets.  Once the site model is placed and coordinates 
are acquired, the building model will automatically know what ‘True North’ should be. 
 
1. Open the architectural building model and open the default 3D View. 

 
2. On the Insert Tab in the Ribbon, select Link Revit, and browse for the Revit Site 

File that has coordinates already established. In the pop-up window prior to opening 
the file, select the following: 

a. Positioning: Center to Center or Origin to Origin 
 

Note: The coordinate system in the building model has not been set up yet; 
therefore, importing by Shared Coordinates will not work. We must manually 
place the cad file in the correct position prior to acquiring coordinates. 
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3. Relocate the site file to the appropriate height.   

 
a. In this example, the building was originally 

modeled at ‘0’ for the First Floor level.  The site file 
comes in at correct heights above 0. 
 

b. Based on the initial footprint placement by the civil 
engineer and previous discussions, I know the 
Finish Floor Elevation of this project will be at 811’.   
 

c. Leave the building in place and move the site file 
down 811’ in elevation to place at the correct 
height in relation to the building. 
 

FIGURE 15 – 

SYNCHRONIZING “SITE” AND “BUILDING” 
FILE COORDINATES 

 
4. Open the First Floor Plan and rotate/move the site file to the correct location under 

the building. 
 

a. After moving the site file down, it should be visible in the First Floor view.   
 

i. If the linked Site file is not visible, turn it on in your view’s Visibility 
Graphics. 
 

b. Move and rotate the site plan as needed so that your building is placed on 
Civil’s footprint. 
 

i. If the cad file is not visible in the floor plan view, change the graphic 
appearance of the linked Site File: Visibility Graphics → Revit Links 
→ Display Settings Button: By Linked View → Basics Tab → Select 
the Site view from the Linked Model (or desired view) 
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FIGURE 16 – VISIBILITY GRAPHICS DIALOG: LINKED VIEWS 

 
5. Once the linked Site file is in the appropriate location (X, Y, & Z), Acquire 

Coordinates from the Site File.   
 
6. Just like in the example above, you can check whether the coordinates are set 

correctly by selecting the Survey Point, unclipping it, and moving it over the visible 
NEZ point in the cad file. 

 

7. Open the Site plan and change the Site view orientation to True North in the 
Properties Palette.  Revit understands the cad file’s True North direction and adjust 
the view accordingly. 

FIGURE 17 – PROJECT NORTH ORIENTATION (LEFT) VS. TRUE NORTH ORIENTATION (RIGHT) 
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Revit – Test the Coordinate System 
 
As a test, link the Architectural Building model into the Site model by Shared Coordinates (as 
opposed to Origin to Origin, etc.). It should pop right into place. 
 

Note: Shared Coordinates does not necessarily mean “real world coordinates”. It 
is a specific Revit term indicating that two or more files share the same 
coordinate system, whatever it may be.  Loading by Shared Coordinates only 
applies when Revit models have gone through the process of Publishing or 
Acquiring Coordinates to or from one another.  

 

Revit – Export Building File back to Civil 
 

The Civil Engineer might benefit from multiple views of the building: 
 

• 1st Floor footprint with door locations  
 

• Roof Plan for building ‘footprint’ style graphics 
 

• 3D view of the building for misc. coordination 
 
 

In 3D views, everything in the view window is exported (including interior objects). 
Consider turning off non-essential interior items. 
 
In general, export views with the ‘building only’. Turn off cad files, topography, and 
site content in your exports.   
 

Note: If you have modified the topo and want to share an alternate grading idea, 
consider sending the modified topo in its own exported 3D view (only topo). This 
way it can be more easily turned on and off on the Civil end. It’s not modifiable, 
but the 3D intent comes through. 

 
1. In the Building Model, open a view to export. Select the File Tab → Export → 

Cad Formats → DWG. Open the additional DWG Export Settings. 

FIGURE 18 - ADDITIONAL EXPORT SETTINGS LOCATION 
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2. In the DWG/ DXF Export Setup window, we are mostly concerned with two items 
here: 

 
a. In the Solids Tab, choose between Polymesh or ACIS solids. (The Civil 

Engineer may have input on which he/she prefers). 
 
b. In the Units & Coordinates Tab, Select Foot for the units, and Shared 

for the Coordinate system. Both selections are very important. 
 

Note that Export Settings can be saved in this dialog window. Create a new 
Export Setup by clicking on the ‘new item’ icon in the bottom left corner. 
 

3. Save the file location and send to Civil. 
 

Civil 3D – Import  Revit’s Exported .DWGS in Real World Coordinates 
 
Since the Revit model has been positioned accurately, there is no longer any need to 
manually place XREF links.  
 
XREF each of the provided .dwg files into your project as desired.  

 

1. During the XREF import process, make 
sure that the following are all unchecked: 

 
a. Scale: Specify on Screen 
b. Insertion Point: Specify on Screen 
c. Rotation: Specify on Screen 

 
 
 

 
 
 
 

FIGURE 19 – ATTACH EXTERNAL 

REFERENCE DIALOG 
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The Architect’s files should pop into 
view in the correct location, orientation, 
and height.  
 
To make the 3D building appear more 
readable, turn on shading in your view. 
 
 

 
 
 
 

FIGURE 20 – XREF OF 3D BUILDING, 
SHADING ON 

 

SECTION #3: Coordinates are Shared… and the Building Needs to Move 

Sometimes buildings need to move on the site after coordinates are shared between Revit 
projects. Perhaps the owner wants to add an additional row of parking, or the city pushes for a 
deeper easement.  Or maybe coordinates are shared too early in design when the building 
hasn’t landed yet.  

 
 
Note the image to the left.  We want to 
avoid Consultants opening their models 
to find the architecture model has 
indeed moved…  and left theirs behind.   
 
Spaces created by linked walls may 
now be unbound, and dimensions and 
items hosted to the linked file likely 
delete themselves altogether.  
 
If Consultants are fully into the CD 
phase, this is a BIG DEAL.   It’s 
important to get the Revit team on the 
same page from the start of the project. 
 
 

      FIGURE 21 – LINKED MODEL SHIFTED EVEN THOUGH  
             COORDINATES ARE STILL SHARED 

 

Revit – Initial Key Discussions  
 

1. Decide as a team with the Owner and Contractor (if known) what models must be 
geo-located and why. 
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2. If all models must be geo-located for your project, avoid acquiring shared 
coordinates from the Architect’s file too early. Design can usually easily progress on 
the consultant’s side while the Architect and Civil Engineer are establishing the final 
location of the building on the site. 

 
3. Model-positioning should be a key line item in BIM project planning/ kickoff 

discussions. Include expectations and responsible parties relating to shared 
coordinates in your project’s BIM execution plan. 
 

Single-Instance Building Projects – Initial Collaboration 
 
1. Architect: Starts model with no coordinate system (typically) and shares their working 

Revit file with Consultants. 
 

2. Consultant: Links the Architect’s Revit model into his/her Revit project by Origin to 
Origin.  Design work begins prior to establishing coordinates. 

 

3. Architect and Consultant models continue to change and update.  
 

a. Linked Local Models: Copies of models are sent back and forth for 
coordination.  Each side updates their links with the ‘Load From…’ option in 
the Manage Links dialog, keeping the linked models in place. 
 

b. Linked BIM 360 Design: Cloud Models update either ‘Live’ at Save-to Central 
points, OR with ‘controlled sharing’ at dedicated publish points. 

 

4. Architect eventually positions their building in the correct coordinate system after 
coordination with Civil. 

 

5. Architect directs the rest of the team to Acquire Coordinates from the Arch. Building 
model and shares the updated model with the team. 

 

6. Consultant Links-in most recent version of Architects model and uses the Acquire 
Coordinates tool to pull the Architectural Model’s coordinate system into the 
Consultant’s project.  

 

If the building never moves, additional steps are not needed.  However, if the 
Consultants take one additional step as an insurance policy, they will be sure to 
avoid the architectural model moving out from under theirs. 

 
 
7. Consultant: Immediately select the Linked Architectural Model. While selected, in the 

Properties Palette Change the ‘Shared Site: Internal’ Location to ‘Do not share site 
of selected instance’. 
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The Consultant’s model stays at the acquired real world coordinates, but the live 
link between the models is broken.  This will ensure that any future changes don’t 
automatically move or rotate the architectural model out from alignment in the 
consultant model without warning. 
 

Consultants will still be able to link-in the Architects Site file by Shared Coordinates. 
 

 

Single-Instance Building Projects – Moving the Building 
 
The following method uses ‘Acquire Coordinates’ only and can be used in both locally hosted 
and cloud hosted models. For this method, we start in the Architectural Building Model. 
 
If the building must move, consider 
the ‘coordinate reset method’. 
Resetting the coordinate system 
prior to moving allows you to 
acquire coordinates in the revised, 
relocated building from scratch. 
 
Link in a ‘throw away’ Revit project 
that simply has default 
coordinates, and then Acquire 
Coordinates from it to reset.   
 
This ‘throw away’ project doesn’t 
have to have much in it… but 
needs to be ‘selectable’ in Revit.  
Consider using large 3D Model 
Text reading “ACQUIRE MY 
COORDINATES TO RESET TO 
0,0,0”. 

FIGURE 22 – LINKED ‘RESET’ MODEL (BLUE) 
CONTAINING 3D TEXT ONLY 

 
 

1. Architect: In the building file, link in the ‘Reset Coordinates’ file into your view and 
Acquire Coordinates from it. The building and site file are no longer using shared 
coordinates and the building file’s coordinates are reset to default.  Delete the ‘Reset 
File’. 
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2. Architect: Move or rotate the site file so that the relationship of the building to the site 
is at the desired new location. When the placement and height of the site is 
established, Acquire the Coordinates from the linked Site file like previously done. 
 

 
If you had chosen to simply rotate the site under your building without 
acquiring coordinates first, you would note that your survey point did not 
rotate with the civil file. And ‘re-acquiring coordinates at this point would not 
work as intended since your survey point is exactly where it was before. Your 
model might look different, but coordinate wise, nothing changed. 
 
Resetting the coordinates from scratch lets you re-determine exactly where 
your building is in relation to Civil’s NEZ point and forces the new location to 
stick.  

 

3. Architect: Let the project team know that the building has shifted and to re-Acquire 
coordinates from the newest model to stay jiving. 

 

4. Consultant: Update the architectural link (choose ‘Reload From… in the Manage 
Links dialog).  Luckily, you had ‘unshared’ the site when you acquired coordinates 
previously, so that the model will not shift out from under you when it is updated in its 
new position. 

 

5. Consultant: Link in your own ‘Reset Coordinates’ file and acquire coordinates from it 
to reset back to default.  Delete the ‘Reset Coordinates’ file and Acquire 
Coordinates from the updated Building model like previously done. 

 

6. Consultant: Immediately Change the ‘Shared Site: Internal’ Location in the 
Architectural like to ‘Do not share site of selected instance’ to break the automatic 
link in case the building shifts again. 

 

7. Rinse and repeat as necessary. 
 

Multi-Instance Buildings on the Same Site 
 

Some project types (multi-family housing, etc.) need to locate multiple copies of a single building 
on a site. In the typical workflow, the building model is linked into the site file and copied to as 
many alternate positions and heights as required.   
 
Each building instance is selected independently and given a specific named ‘site’ location 
which is recorded back within the model link itself when the file is saved. Each individual named 
site understands its location in the Site File and true north orientation. 
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FIGURE 23 – NAMING ALTERNATE SHARED ‘SITES’ FOR MULTIPLE BUILDING INSTANCES. 

 
If a building needs to move, the building instance can be selected in the site file and 
repositioned.  Saving the Site file records the updated location within the linked model. 
 
Recording the Coordinates for multiple sites is very similar to ‘Publishing Coordinates’ in that the 
linked file is actually changed during the process.  And similarly, recording the coordinates is 
also not available in Cloud projects.   
 

For BIM 360 projects, Site instances could be established before the project is 
published to the cloud if possible.  Otherwise, a copy of the site and building 
project can be pulled from the cloud to establish multiple building sites locally. 
Once the sites are located as desired, the files can be pushed back up to the 
cloud with new names to use as the current versions. 

 
An alternate workflow for establishing multiple sites in BIM 360 projects can be found at 
the link below. 
 
https://help.autodesk.com/view/RVT/2019/ENU/?guid=GUID-E4D2529C-7939-4A0F-
82F5-36ABC9D8A3D1 

 

https://help.autodesk.com/view/RVT/2019/ENU/?guid=GUID-E4D2529C-7939-4A0F-82F5-36ABC9D8A3D1
https://help.autodesk.com/view/RVT/2019/ENU/?guid=GUID-E4D2529C-7939-4A0F-82F5-36ABC9D8A3D1
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SECTION #4: Additional Add-ins and Subscription Options 

 
Sections #1 and #2 discussed ‘manual’ methods for creating topography and locating Revit 
projects in Civil’s defined coordinate system.  These workflows work in any version of Revit and 
Civil 3D and are not tied to specific add-ins or subscriptions.  They are good workflows to have 
in your pocket, regardless. 
 
However, Autodesk is continually looking for additional ways to better connect their family of 
products. This section introduces an optional plug-in for quickly establishing coordinates in a 
building file, and a brief overview of the BIM 360 Cloud option for improved topography 
collaboration. 
 

Shared Reference Point Extension  
 
The Shared Reference Point Extension workflow allows the Revit users to align two points in 
their model to two points previously selected in the Civil model. 
 
Requirements: 
Both Revit and Civil 3D users must download and install the Autodesk Shared 
Reference Point Extension for their programs.   
 
In this example, we will be selecting our points at two places on the building. 
 

Civil 3D  
 
1. Decide upon two points on the building or site that can be selected easily in Revit. 

 
a. In this example, we are using two points on the building at the finish floor 

level. We have a recent cad file from the architect and know the building 
shape is current.  We also know floor level is an easy datum/ plane for 
selection in Revit.   
 

b. The points selected should align in a quasi-north arrangement. 
 

Though not necessary, consider providing 
‘directions’ on a dedicated layer in your cad file 
noting your ‘click’ locations and order.  We have 
chosen to add text at click points indicating ‘CLICK 
1’ and CLICK 2’ connected by a line.  The points 
and line are at the intended first floor height. 
 

FIGURE 24 – DIRECTIONS FOR 

CLICK ORDER 

 

2. In the Toolspace panel, Toolbox Tab, expand ‘Subscription Extension Manager’ 
and select Autodesk Shared Reference Point. 



 

 

25 

 
3. Click the first point, and then click the quasi-north second point. 
4. In the pop-up window, select your units (it defaults to meters), and provide the 

Architect with the created XML file 

Revit 
 
Here we will be locating the building with the Shared Reference Point tool as an 
alternative to Acquiring coordinates from the Site File (or in an imported cad file directly 
in our building model). 
 
1. Open the First Floor Building floor plan.  On the Add-ins tab, select Import Shared 

Coordinates from XML file. 
 

2. Select the two points that Civil chose in the proper order and vertical height.  If you 
have the cad file linked in, you can review Civil’s directions and click points. 

 

FIGURE 25 – SELECT TWO POINTS IN REVIT 

 

3. In the pop-up window, select the provided XML file. Select ‘yes’ to create a new 
shared coordinate system. 

 

4. A new coordinate system option has been added to the project; however, it still 
needs to be set to ‘current’ to apply any changes.   

 
a. On the Manage Tab, select ‘Location’ to open the Weather and Site dialog 

box. 
 

b. Select the Site Tab and select the newly created coordinate system.   
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c. Before closing this window, select ‘Make Current’ to change coordinate 
systems to this one. 

 

 

 
FIGURE 26 – LOCATION WEATHER AND SITE DIALOG 

 
5. The Building file now shares the same coordinate system with Civil. 

 
 

 
 

Shared Topography Option in BIM 360 Design 
 

The ‘Publish- Link Topography’ workflow in BIM 360 projects allows Civil 3D and Revit to have a 
more streamlined collaborative process.  Civil 3D users publish ‘just the surface’ of a file to the 
cloud project and Revit pulls it in as a Toposurface without additional work.   
 

Requirements: 
Revit User and Civil 3D user must download and install Autodesk Desktop Connector. 
Revit user and Civil 3D user must have access to the same BIM 360 Cloud Project. 
 

Civil 3D  
 
1. Once a surface has been created, select the Collaborate tab → Publish Surface. 
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2. n the Publish Surfaces 

dialog box, select the 
intended surface. Note 
that grid surfaces and 
surfaces with more than 
one million points are not 
able to be published. 

 

3. Specify the output file 
location in the cloud 
project (image) and 
Save. 

 
 
 

 
 

FIGURE 27 – PUBLISH SURFACES DIALOG AND  
OUTPUT FILE LOCATION 

 

 

Revit 
 
1. Open a 3D view of the project.  On the Insert tab, select ‘Link Topography’. 

Browse to the location in the Cloud Project Folder Structure with the desired surface 
file.  Select ‘Link. 

 
Note: If the Revit file already shares Civil’s coordinates system, the topo will be 
inserted automatically with shared coordinates.  If no coordinates have been 
previously established, center-to-center positioning will be used and the topo 
must be manually positioned in space.  Refer to the Coordinates workflow in 
Section #2 above to establish coordinates for the project. 
 
Note: The ‘Link Topography’ workflow does not bring in Civil’s cad background or 
additional line data… just the surface itself. 

 
Revit does a much better job smoothing out curbs and other vertical rises than the 
manual workflow shown in Section #1 above.  However, if curbs are not as pronounced 
as you’d like, consider adjusting the topo line increment in Revit. 
 
2. On the Massing and Site Tab in the Model Site area, select the lower-right arrow to 

open the Site Settings dialog.  Adjusting the contour increment to 3” allows 6” tall 
curbs to be much more pronounced. 
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FIGURE 28 – SITE SETTINGS DIALOG   FIGURE 29 – SMOOTH CURBS 

 
 
Revit automatically creates a Revit Toposurface from the linked file.  Though the 
topography is linked, the following items are still applicable: 
 

• Topography can host Revit Building Pads 

• Subregions can be added 

• Revit Materials can be added 

• Topography can host objects 

• Topography can host spot elevations 
 

Updating Linked Topography 
 
If/when the topography is updated in Civil 3D, the surface can be re-published to the 
Cloud Project by following the same ‘publishing’ workflow above.  On the Revit side, the 
Architect can simply ‘Reload From’ in the Manage Links dialog to update the 
Toposurface in-place.   Pads, Subregions, materials, elevations, hosted objects, and 
spot elevations are not deleted… they update to the new topo heights automatically. 
 
 

CONCLUSION 

Revit and Civil 3D workflows will only continue to get better—and new add-ins and BIM 360 
workflows are moving in the right direction.  Whether you adopt manual or specialty workflows 
for coordinating between the two programs, standardize, simplify, and document your process 
for better, more effective collaboration on Revit and Civil 3D projects. 
 
END OF CLASS HANDOUT 


